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Shiny application development

Migale facility - 2023/03/20

Sandra Dérozier - Mahendra Mariadassou - Cédric Midoux

(Orignal slides from Amandine Velt and Cédric Midoux)​
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• 9h30 - 17h00

• 2 breaks (morning and afternoon)

• Lunch break of 1 hour

Practical informations
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• Who are you?
• Institution, laboratory, position…

• Why are you here?
• What are your goals with Shiny?

• Do you already have developments in progress?

• Have you ever used Shiny?

Ice breaking session
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• After this training day, you will know:
• General concepts of a Shiny app

• Shiny application development

• Shiny application deployment solutions

Objectives 



p. 5Migale facility
March 20, 2023 / Sandra Derozier - Mahendra Mariadassou - Cédric Midoux

• Morning
• 09h30 : Opening
• 10h00 : Why Shiny?
• 10h30 : Server/UI + input/output + Widgets
• 12h00 : Layout + CSS

• Afternoon
• 14h00 : Reactivity
• 15h30 : Deployment
• 16h30 : Conclusion + Q&A
• 17h00 : End of day

Schedule
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Why Shiny?
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How to communicate one's results with R?

R for data analysis

Garrett Grolemund & Hadley Wickham

https://r4ds.had.co.nz/
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x <- faithful$waiting

# number of bins = 10

nbins <- 10

hist(x, breaks = nbins, col = "#75AADB", 

border = "white",

xlab = "Waiting time to next eruption (in mins)",

main = "Histogram of waiting times")

# number of bins = 50

nbins <- 50

hist(x, breaks = nbins, col = "#75AADB", 

border = "white",

xlab = "Waiting time to next eruption (in mins)",

main = "Histogram of waiting times")

With R, to change a parameter, you have to change the code manually.

We would like to have a slider to modify it interactively!
Shiny solution: https://gallery.shinyapps.io/001-hello/

How to communicate its results with R?

https://gallery.shinyapps.io/001-hello/
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shiny::runExample("01_hello")

Shiny brings reactivity

How to communicate one's results with R?
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How to communicate one's results with R?

R for data analysis

Garrett Grolemund & Hadley Wickham

With Shiny

https://r4ds.had.co.nz/
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• Defining features:
• Facilitates dataviz and data mining...

• ...through simple, readable and user-friendly interfaces

• ...and dynamic outputs: graphs, tables, etc

• Reduces the required amount of code to learn / write (if 
you already know R)

Shiny to ease access to data
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How to communicate its results with R?

Share your raw code 
• No context or 

comments
• Can be difficult to 

interpret
• No dependency 

management

Use Rmarkdown
• Static report 

retracing analysis
• No re-execution 

Implement a Shiny 
application
• User-frienldy 

graphical interface
• Editable 

parameters and re-
executable code

• Ability to export 
plots and reports

• User should install 
R and packages

Deploy the Shiny app 
on a server
• Applications run on 

a dedicated serve
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https://shiny.rstudio.com/

https://shiny.rstudio.com/
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Tutorials

https://shiny.rstudio.com/tutorial/

Gallery

https://shiny.rstudio.com/gallery/

https://shiny.rstudio.com/tutorial/
https://shiny.rstudio.com/gallery/
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• Pick one of these Shiny apps and interact with it

• Try to see how the app behaves and what can be 
done with it
• ECDC-vaccination et dataCoViz de @flodebarre

• Covid19-tracker de Edward Parker

• Movie explorer

• Legislatives2017

• Any one from the gallery

Let's play with Shiny!

https://fdebarre.shinyapps.io/ecdc-vaccination
https://fdebarre.shinyapps.io/dataCoViz/
https://twitter.com/flodebarre
https://shiny.rstudio.com/gallery/covid19-tracker.html
https://shiny.rstudio.com/gallery/movie-explorer.html
https://thinkr.shinyapps.io/legislatives2017
https://shiny.rstudio.com/gallery
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How does it work?
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• Create a Shiny application with RStudio 
• File > New File > Shiny Web App

• Give a name to your first app and save it in the folder 
of your choice with the option "Single File"

• Browse, explore and execute the code

• Identify each element and their interactions

How does it work?
→ TP1
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server.Rui.R
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server.R

Inputs widgets

Output display

Creation
Update

Output computation

Load packages and data

ui.R
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server.Rui.R

*Input(inputId = « in1 »,

label = «lab»),

*Output(outputId = « out1 »)

output$out1 <-

render*(input$in1)

library(...)

sliderInput

plotOutput
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ui.R server.R
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server.R

ui.R

Inputs widgets

Which ones
would you need?

Various types of inputs widgets
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server.R

ui.R

Inputs widgets https://shiny.rstudio.com/gallery/widget-gallery.html

Various types of inputs widgets

https://shiny.rstudio.com/gallery/widget-gallery.html
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server.R
ui.ROutputs

Various types of outputs 
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→ TP2: Add text

→ TP3: Pick a title

→ TP4: Add color

Practical work
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Layout
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• UI returns HTML document

• HTML tags can be added to the ui

• To include a CSS file, use the includeCSS() function 
and place the file in the www folder

Layout
Add CSS / HTML / Javascript
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server.R
ui.R

fluidPage() fits the 
width of the browser

Layout
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server.R
ui.R

Many layouts are 
available

fluidPage() fits the 
width of the browser

Layout
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Layer tabPanels
ui <- fluidPage(

sidebarLayout(

sidebarPanel(…)

mainPanel(

tabsetPanel(

tabPanel("Plot", "content"),

tabPanel("Summary", "content"),

tabPanel("Table", "content")

)

)

)

)

ui <- fluidPage(

navbarPage(title="Navbar!",

tabPanel("Plot", "content"),

tabPanel("Summary", "content"),

tabPanel("More", "content")

))
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Using the shinydashboard package, 
you can easily create a dashboard type 

applications like:

Shiny Dashboard
library(shinydashboard)

dashboardPage(

dashboardHeader(),

dashboardSidebar(),

dashboardBody()

)
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3 ways to include CSS:

• insert the style in the head

• insert the style at the tag level, through the style
attribute, also known as inline CSS

• point to an external file with includeCSS(”style.css”)

CSS
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Insert the style in the head

CSS

ui <- fluidPage(

tags$head(

tags$style(HTML(“

/* Change font of header text */

h2 {

font-family: ‘monospace’;

}

/* Make text visible on inputs */

.shiny-input-container {

color: #474747;

}”))

),

titlePanel(“Old Faithful Geyser Data”),

...

)

ui.R
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Insert the style at the tag level, through the style
attribute, also known as inline CSS

CSS

ui <- fluidPage(

# titlePanel(“Old Faithful Geyser Data”),

h2(“Old Faithful Geyser Data”, style = “font-family: monospace;”),

...

)

ui.R
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Point to an external file with includeCSS(“style.css”)

CSS

ui <- fluidPage(

includeCSS(“www/style.css”),

titlePanel(“Old Faithful Geyser Data”),

...

)

ui.R

/* Change font of header text */

h2 {

font-family: ‘monospace’;

}

/* Make text visible on inputs */

.shiny-input-container {

color: #474747;

}

style.css



p. 36Migale facility
March 20, 2023 / Sandra Derozier - Mahendra Mariadassou - Cédric Midoux

→ TP5: Multi-tab applications and customization with 
CSS

→ TP6: Simulations

Practical work
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Reactivity
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• Each change of input$x (in the user interface) 
induces output$y to be re-evaluated
• The render* functions family will re-execute the code 

as soon as one of the inputs it depends on changes

• In the initial example, when input$bins changes, the 
plot function is re-computed

The reactivity of Shiny app
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At each change of input$x (in the user interface), 
output$y is re-evaluated.

The reactivity graph of Shiny applications
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We can add reactive expression() for caching values.
Call the expression with function syntax, like re()

Reactivity in Shiny applications

ui <- fluidPage(

textInput("a","","A"),

textInput("z","","Z"),

textOutput("b"))

server <- function(input,output){

re <- reactive({

paste(input$a,input$z)})

output$b <- renderText({

re()

})

}

shinyApp(ui, server)
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We run some only after an observe 
event like press a button.

Reactivity in Shiny applications

library(shiny)

ui <- fluidPage(

textInput("a","","A"),

actionButton("go","Go")

)

server <- function(input,output){

observeEvent(input$go,{

print(input$a)

})

}

shinyApp(ui, server)
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In the same way, you can update an 
output when we obverse an event.

Reactivity in Shiny applications

library(shiny)

ui <- fluidPage(

textInput("a","","A"),

actionButton("go","Go"),

textOutput("b")

)

server <- function(input,output){

re <- eventReactive(

input$go,{input$a})

output$b <- renderText({

re()

})

}

shinyApp(ui, server)
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→ TP7: Add new data

→ TP8: Work with randomly generated data

→ TP9: Specify the generating distribution

→ TP10: Upload your data

→ …

Practical work
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Exploring reactivity with reactlog

> reactlog::reactlog_enable()
> runApp(‘reactlog.R’)
> shiny::reactlogShow()

Allows you to play the app “step-by-step” and examine what’s going 
on under the hood.
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Exploring reactivity with reactlog

• animated version
• all images adapted from the official documentation

https://rstudio.github.io/reactlog/
https://rstudio.github.io/reactlog/articles/reactlog.html
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Nodes in the graph
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A session begins
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Execution begins
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Reading a reactive expression
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Reading an input
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Reactive expression completes
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Observer completes
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The next observer executes
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Execution completes, outputs flushed
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An input changes
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Notifying dependents
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Removing relationships
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Re-execution
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Share a Shiny app
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• Sharing the code with the user
• GitHub repository (shiny::runGitHub and 

shiny::runURL)

• R package (build with golem) that the user will install 
locally

• Disadvantage: requires to install R and manage the 
packages installation

Share a Shiny app
Local deployment
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• App is hosted on RStudio servers
• Free formula : 5 Shiny app, 25 actives hours/month

• Scalable formula : since $9/month to $300/month

• 1-click deployment

• User-friendly tracking dashboard

• Disadvantage: Freemium and RStudio dependency

https://docs.rstudio.com/shinyapps.io/

Share a Shiny app
shinyapps.io

https://docs.rstudio.com/shinyapps.io/
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Share a Shiny app
shinyapps.io

→ TP14: Deploy an app with shinyapps.io
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Building with {golem}

• {golem} is a package to ease the development and deployment of shiny 
app (like {usethis})

• Description, automatic dependencies, unit test, inline 
documentation, etc

• Install with install.packages("golem")
• Create a shiny app as a package with golem

• File > New Project > Package for Shiny App Using golem

• Fill in and execute dev/01_start.R

• Add modules dev/02_dev.R and populate ui / server

• Launch app using dev/run_dev.R

• Deploy using dev/03_deploy.R

https://thinkr-open.github.io/golem/index.html
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• If your application is stable and packaged, we can 
host it
• Scientific field of interest (life sciences)

• Packaged application (like golem)

• Using docker (we can help you)

• GitHub / GitLab versioning

• No huge computations

Host the app on Migale
https://shiny.migale.inrae.fr/

https://shiny.migale.inrae.fr/
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• The SK8 project aims at setting up a hosting service 
for R-Shiny Applications with the tools and 
infrastructures made available in INRAE.

Host the app on SK8
https://sk8.inrae.fr/

https://shiny.migale.inrae.fr/
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• Shiny allows you to make an R script interactive, 
easily

• Shiny is the ideal solution for sharing and exploring 
results

• Several deployment solutions exist and work well, 
depending what is needed

• Need to optimize your application because latency 
and memory problems can quickly occur

Take Home Message
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● References : 
○ Mastering Shiny : https://mastering-shiny.org/
○ Gallery: https://shiny.rstudio.com/gallery/
○ Gallery widget: https://shiny.rstudio.com/gallery/widget-gallery.html
○ CheatSheet : https://shiny.rstudio.com/images/shiny-cheatsheet.pdf
○ CheatSheet VF : https://thinkr.fr/pdf/shiny-french-cheatsheet.pdf
○ Engineering Shiny ( &{golem}): https://engineering-shiny.org/

● See also :
○ Building a Wordle App with Shiny!: https://youtube.com/playlist?list=PL9HYL-

VRX0oQnWIeY_ydYBdU76iQ-tchU

○ Awesome shiny : https://github.com/nanxstats/awesome-shiny-extensions
○ Docs SK8 (VF, hébergement & Bonnes pratiques shiny) : https://docs.sk8.inrae.fr
○ Golem : https://thinkr-open.github.io/golem/

Sources

https://mastering-shiny.org/
https://shiny.rstudio.com/gallery/
https://shiny.rstudio.com/gallery/widget-gallery.html
https://shiny.rstudio.com/images/shiny-cheatsheet.pdf
https://thinkr.fr/pdf/shiny-french-cheatsheet.pdf
https://engineering-shiny.org/
https://shiny.rstudio.com/gallery/
https://github.com/nanxstats/awesome-shiny-extensions
https://docs.sk8.inrae.fr/
https://thinkr-open.github.io/golem/
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● Tuto :
○ Official : https://shiny.rstudio.com/tutorial/
○ Introduction à Shiny (VF) :http://perso.ens-lyon.fr/lise.vaudor/Tuto_Shiny/
○ Formation IFB (VF) : https://github.com/IFB-ElixirFr/IFB_Shiny_training
○ UI organisation : https://speakerdeck.com/jcheng5/styling-shiny

● Blog :
○ https://blog.rstudio.com/categories/shiny/
○ https://bioinfo-fr.net/rendre-ses-projets-r-plus-accessibles-grace-a-shiny
○ https://superstatisticienne.fr/r-sur-le-web-le-package-shiny/
○ https://thinkr.fr/a-decouverte-de-shiny/

Sources

https://shiny.rstudio.com/tutorial/
http://perso.ens-lyon.fr/lise.vaudor/Tuto_Shiny/
https://github.com/IFB-ElixirFr/IFB_Shiny_training
https://speakerdeck.com/jcheng5/styling-shiny
https://blog.rstudio.com/categories/shiny/
https://bioinfo-fr.net/rendre-ses-projets-r-plus-accessibles-grace-a-shiny
https://superstatisticienne.fr/r-sur-le-web-le-package-shiny/
https://thinkr.fr/a-decouverte-de-shiny/
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More about reactlog
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Exploring reactivity: app9

datasetInput depends on and reacts to 
many producers. 
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App9_bis: ugly dependency graph

Both observers update 
datasetInput()

Note: observers break the 
natural dependency / 
reactivity graph
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Dependency without reactivity Reactivity broken by 
bindEvent()

RandomData() updated in 
bindEvent()
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Reactivity versus dependencies

Reacts to (and depends on) any 
parameter change

Reacts only to clicks on update button 
but depends on more parameters 
(randomN, randomMean, randomSd). 

Dependency without reactivity,thanks to 
bindEvent()
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App9_ter: straighforward dependencies


